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Preface

Oracle Identity Manager Connector Guide for PeopleSoft Employee Reconciliation provides 
information about integrating Oracle Identity Manager with PeopleSoft HRMS or 
PeopleSoft HCM.

Audience
This guide is intended for users who want to deploy the Oracle Identity Manager 
connector for PeopleSoft HRMS or PeopleSoft HCM.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Deaf/Hard of Hearing Access to Oracle Support Services
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call 
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle 
technical issues and provide customer support according to the Oracle service request 
process. Information about TRS is available at 
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone 
numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html.
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Related Documents
For information about installing and using Oracle Identity Manager, see the Oracle 
Identity Manager documentation library.

For generic information about connectors, see Oracle Identity Manager Connector 
Concepts.

The following Oracle Technology Network page provides links to Oracle Identity 
Manager documentation:

http://www.oracle.com/technology/documentation/oim.html

Documentation Updates
Oracle is committed to delivering the best and most recent information available. For 
information about updates to the Oracle Identity Manager Connector Pack Release 
9.0.4 documentation library, visit Oracle Technology Network at

http://www.oracle.com/technology/documentation/index.html

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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What's New in the Oracle Identity Manager
Connector for PeopleSoft Employee

Reconciliation?

This chapter provides an overview of the updates made to the software and 
documentation for the PeopleSoft Employee Reconciliation connector in release 9.0.4.1 
of the Oracle Identity Manager connector pack.

The updates discussed in this chapter are divided into the following categories:

■ Software Updates

These include updates made to the connector software.

■ Documentation-Specific Updates

These include major changes made to the connector documentation. These 
changes are not related to software updates.

Software Updates
This section discusses updates made to this release of the connector software.

New Supported Target Systems
This release of the connector supports PeopleTools 8.47 and 8.48. The required content 
has been added at appropriate places in this guide.

Documentation-Specific Updates
The following documentation-specific update has been made in this release of the 
guide:

■ In this guide, the name of the target system has been changed from PeopleSoft 
Employee Reconciliation to PeopleSoft HRMS or PeopleSoft HCM.

■ In the "Employee Data Reconciliation" section on page 1-2, information on full 
reconciliation and incremental reconciliation has been modified.

See Also: The 9.0.4 release of this guide for information about 
updates that were new for the 9.0.4 release

See Also: Oracle Identity Manager Release Notes
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■ The structure of the "Configuring the Target System" section on page 3-1 has been 
modified.

■ The structure of Chapter 3, "Configuring the Target System and Oracle Identity 
Manager" has been modified.

■ In the "Multilanguage Support" section, Arabic has been added to the list of 
languages that the connector supports.

■ In the "Step 1: Verifying Deployment Requirements" section, changes have been 
made in the "Target system" row.
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1
About the Connector

Oracle Identity Manager automates access rights management, security, and 
provisioning of IT resources. Oracle Identity Manager connectors are used to integrate 
Oracle Identity Manager with third-party applications. 

This guide discusses the procedure to deploy the PeopleSoft Employee Reconciliation 
connector that is used to integrate PeopleSoft HRMS/HCM with Oracle Identity 
Manager. This connector provides a means to exchange real-time data between the 
target system and Oracle Identity Manager.

The PeopleSoft Employee Reconciliation connector enables the target system as an 
authoritative identity source of Oracle Identity Manager through trusted source 
reconciliation. The connector supports trusted source reconciliation in two ways:

■ Full reconciliation

Full reconciliation involves reconciling records of employees by using a flat file. A 
PeopleCode event is activated when employee information is updated in the target 
system. The PeopleCode then extracts the required employee information. A 
PeopleSoft Application Engine program then populates the flat file with this 
information. The flat file is read by an Oracle Identity Manager scheduled task that 
generates reconciliation events. 

The PeopleSoft Application Engine program is run using PeopleSoft Application 
Designer or PeopleSoft Internet Architecture (PIA).

To reconcile all existing target system records into Oracle Identity Manager, you 
must run full reconciliation the first time you perform a reconciliation run after 
deploying the connector. This is to ensure that the target system and Oracle 
Identity Manager contain the same data. In subsequent reconciliation runs, only 
data that is modified since the last reconciliation is reconciled. Oracle recommends 
that you run full reconciliations periodically to ensure that all the employee 
records are reconciled into Oracle Identity Manager. See "Configuring the Target 
System for Full Reconciliation" on page 3-1 for more information.

■ Incremental reconciliation

Incremental reconciliation involves real-time reconciliation of newly created or 
modified employee information. Usually, this type of reconciliation is used for 

Note: In this guide, the term Oracle Identity Manager server refers 
to the computer on which Oracle Identity Manager is installed.

In this guide, PeopleSoft HRMS/HCM has been referred to as the 
target system.
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reconciling individual data changes after an initial reconciliation is performed 
using full reconciliation. The PeopleCode captures changes to the same PeopleSoft 
components as applicable for full reconciliation and forwards these changes in real 
time to a Java Servlet listener running on the Oracle Identity Manager server 
through an HTTP POST request. Incremental reconciliation is performed using 
PeopleSoft application messaging. See "Configuring the Target System for 
Incremental Reconciliation" on page 3-4 for more information.

The synchronization process from the target system to Oracle Identity Manager 
involves the following steps:

1. When employee information is added or updated in the target system, a 
PeopleCode event is activated.

2. The PeopleCode event generates an XML message containing the added or 
updated employee information and sends it to the connector by using HTTP.

3. The connector parses the XML message and sends a reconciliation event to 
Oracle Identity Manager.

This chapter contains the following sections:

■ Employee Data Reconciliation

■ Supported Functionality

■ Multilanguage Support

■ Files and Directories That Comprise the Connector

■ Determining the Release Number of the Connector

Employee Data Reconciliation

The following target system fields must be reconciled:

■ EmplID

■ First Name

■ Last Name

■ Organization

■ User Type

■ Employee Type

You can also configure reconciliation for the following fields of the target system. To 
do so, you must define custom attributes for each field in Oracle Identity Manager.

■ BirthDate

■ Sex

■ City

■ SSN

■ Phone

■ Country

See Also: The "Deployment Configurations of Oracle Identity 
Manager" section in Oracle Identity Manager Connector Concepts Guide 
for conceptual information about reconciliation configurations



Files and Directories That Comprise the Connector

About the Connector 1-3

■ Address

■ State

■ DeptId

■ JobCode

■ Postal

■ HireDate

For information about adding custom attributes, see "Adding Custom Attributes for 
Full Reconciliation" on page 3-21.

Supported Functionality
Table 1–1 lists the functions that are available with this connector.

Multilanguage Support
The connector supports the following languages:

■ Arabic

■ Chinese Simplified

■ Chinese Traditional

■ Danish

■ English

■ French

■ German

■ Italian

■ Japanese

■ Korean

■ Portuguese (Brazilian)

■ Spanish

Files and Directories That Comprise the Connector
The files and directories that comprise this connector are compressed in the following 
directory on the installation media:

Table 1–1 Supported Functionality

Function Type Description

Trusted Employee 
Reconciliation

Reconciliation Reconciles newly added or modified employee 
data from the target system to Oracle Identity 
Manager.

See Also: Appendix A for information about attribute mappings 
between Oracle Identity Manager and the target system.

See Also: Oracle Identity Manager Globalization Guide for information 
about supported special characters
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Enterprise Applications/PeopleSoft Enterprise Applications/PeopleSoft Employee 
Reconciliation

These files and directories are listed in the following table:

File in the Installation Media Directory Description

config/configureReconciliation.properti
es

This file contains the date format used for full reconciliation. The 
date format is used on both the PeopleSoft server and Oracle 
Identity Manager.

config/attributemapping_recon.propertie
s

This file lists the target system attributes and their mappings to 
corresponding fields in Oracle Identity Manager.

ext/csv.jar This file is a third-party library that is used to read 
comma-separated files.

lib/xlPSFTHRRecon.jar This JAR file contains the class files that are used to implement 
full reconciliation.

lib/peopleSoftApp.war This Web Archive (WAR) file contains the classes and 
configuration files required to implement incremental 
reconciliation.

For PeopleTools 8.22, the following file in the 
lib/MsgPublisher directory:

xliMsgPublisher.jar

This JAR file contains the class file that transfers the XML 
messages generated by the PeopleTools 8.22 file handler on the 
PeopleSoft Web server to the PeopleSoft connector.

For PeopleTools 8.22, the following file in the 
scripts directory:

publish.bat

The publish.bat file is used to trigger message transfers on a 
periodic basis. Refer to the "Configuring PeopleSoft Integration 
Broker" section on page 3-11 for more information.

For PeopleTools 8.22:

PeopleCode/PT822/HRMSCBRecon.txt

For PeopleTools 8.45 through 8.47:

PeopleCode/HRMSCBRecon_8.45-8.47.txt

For PeopleTools 8.48:

PeopleCode/HRMSCBRecon_8.48.txt

This file contains the PeopleCode that you must add to the 
SavePostChange event while performing the procedure 
described in the "Publishing the Message" section on page 3-8.

For PeopleTools 8.22:

PeopleCode/PT822/HRMSBulkRecon.txt

For PeopleTools 8.45 through 8.48:

PeopleCode/HRMSBulkRecon.txt

This file contains the PeopleCode that gets executed during full 
reconciliation to generate the flat file.

Files in the resources directory Each of these resource bundle files contains language-specific 
information that is used by the connector.

Note: A resource bundle is a file containing localized versions of 
the text strings that are displayed on the user interface of Oracle 
Identity Manager. These text strings include GUI element labels 
and messages displayed on the Administrative and User 
Console.

test/cbrecon/psft-xel-test.vbs This VBScript file can be used to test the incremental 
reconciliation functionality of the connector by creating a dummy 
XML message similar to the ones created by the target system.
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The "Step 2: Copying the Connector Files and External Code Files" section on page 2-2 
provides instructions to copy these files into the required directories.

Determining the Release Number of the Connector
You can use the following method to determine the release number of a PeopleSoft 
Employee Reconciliation connector.

1. Extract the contents of the xlPSFTHRRecon.jar file. This file is in the following 
directory on the installation media:

Enterprise Applications/PeopleSoft Enterprise Applications/PeopleSoft Employee 
Reconciliation/lib

2. Open the manifest.mf file in a text editor. The manifest.mf file is one of the 
files bundled inside the xlPSFTHRRecon.jar file.

In the manifest.mf file, the release number of the connector is displayed as the 
value of the Version property.

test/cbrecon/pingRequest.xml
test/cbrecon/pingResponse.xml
test/cbrecon/publishRequest.xml
test/cbrecon/publishResponse.xml

These XML files are required by the psft-xel-test.vbs file 
for communicating with the connector by using XML over HTTP.

test/cbrecon/psft_xellerate_msg.xml This XML file is used by the psft-xel-test.vbs file to define 
the template of the XML message that is received from the target 
system.

xml/adpPSFT_RECON_DM.xml This XML file contains definitions for the following components 
of the connector:

■ Resource object

■ Process definition

■ IT resource type

■ Reconciliation rules

■ Scheduled tasks

■ Process form

xml/adpPSFT_XellerateUser_RECON_DM.xml This XML file contains the configuration information for the 
Xellerate User resource object. You must import this file after you 
import the adpPSFT_RECON_DM.xml file.

This XML file contains definitions for the following components 
of the connector:

■ Resource object

■ Process definition

■ Scheduled tasks

■ Process form

Note: If you maintain a copy of the xlPSFTHRRecon.jar file after 
deployment, you can use this method whenever you want to 
determine the release number of the connector. After you deploy the 
connector, Oracle recommends that you use the "After Deployment" 
method, which is described in the following section.

File in the Installation Media Directory Description
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2
Deploying the Connector

Deploying the connector involves the following steps:

■ Step 1: Verifying Deployment Requirements

■ Step 2: Copying the Connector Files and External Code Files

■ Step 3: Configuring the Oracle Identity Manager Server

■ Step 4: Importing the Connector XML Files

Step 1: Verifying Deployment Requirements
To verify deployment requirements for the PeopleSoft Employee Reconciliation 
connector:

1. Ensure that your environment meets the requirements listed in the following table.

Note: In this guide, PeopleSoft HRMS/HCM has been referred to as 
the target system.

Item Requirement

Oracle Identity Manager Oracle Identity Manager release 8.5.3 or later

Target system The following are the supported target systems and 
the PeopleTools versions for each:

■ PeopleSoft HRMS 8.3 SP1 with PeopleTools 8.22

■ PeopleSoft Enterprise HCM 8.9 with PeopleTools 
8.45 through 8.47

■ PeopleSoft Enterprise HCM 9.0 with PeopleTools 
8.48

You must ensure that the following components are 
installed and configured:

■ Tuxedo and Jolt (the application server)

■ PeopleSoft Internet Architecture

Target system host platform Applications running on PeopleTools 8.22 and 
PeopleSoft HRMS 8.3 SP1 are supported only on 
Microsoft Windows platforms. For applications 
running on any other supported PeopleTools 
versions, there is no platform dependency.
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2. Ensure that you have administrative rights on the target system server to 
configure the "Configuring PeopleSoft Integration Broker" component.

Step 2: Copying the Connector Files and External Code Files
The files to be copied and the directories to which you must copy them are given in the 
following table:

External code The csv.jar external code file is included in the 
installation media directory for this connector.

Refer to the "Files and Directories That Comprise the 
Connector" section on page 1-3 for more information 
about these files.

Note:

- The directory paths given in the first column of this table correspond 
to the location of the connector files in the following directory on the 
installation media:

Enterprise Applications/PeopleSoft Enterprise 
Applications/PeopleSoft Employee Reconciliation

Refer to the "Files and Directories That Comprise the Connector" 
section on page 1-3 for more information about these files.

- If a particular destination directory does not already exist on the 
Oracle Identity Manager server, then create it.

File in the Installation Media Directory Destination Directory

Files in the config directory OIM_HOME/xellerate/XLIntegrations/PSFTHR/config 

ext/csv.jar OIM_HOME/xellerate/ThirdParty

lib/peopleSoftApp.war OIM_HOME/cbrecon_webapp/lib

lib/xlPSFTHRRecon.jar OIM_HOME/xellerate/ScheduleTask

For PeopleTools 8.22, copy the files from the 
lib/MsgPublisher directory

OIM_HOME/xellerate/MsgPublisher

For PeopleTools 8.22, copy the files from the 
PeopleCode/PT822 directory

For PeopleTools 8.45 through 8.48, copy the files from 
the PeopleCode directory

OIM_HOME/xellerate/scripts

Note: You must copy the files for either PeopleTools 8.22 
or PeopleTools 8.45 through 8.48. Do not copy both sets 
of files. 

Copy the files from the resources directory OIM_HOME/xellerate/connectorResources

Files in the test/cbrecon directory OIM_HOME/xellerate/XLIntegrations/PSFTHR/cbrecon

Files in the xml directory OIM_HOME/xlclient

Item Requirement
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Step 3: Configuring the Oracle Identity Manager Server
Configuring the Oracle Identity Manager server involves the following procedures:

■ Changing to the Required Input Locale

■ Clearing Content Related to Connector Resource Bundles from the Server Cache

■ Enabling Logging

Changing to the Required Input Locale
Changing to the required input locale (language and country setting) involves 
installing the required fonts and setting the required input locale.

You may require the assistance of the system administrator to change to the required 
input locale.

Clearing Content Related to Connector Resource Bundles from the Server Cache
While performing the procedure described in the "Step 2: Copying the Connector Files 
and External Code Files" section on page 2-2, you copy files from the resources 
directory on the installation media into the 
OIM_HOME/xellerate/connectorResources directory. Whenever you add a new 
resource bundle in the connectorResources directory or make a change in an 
existing resource bundle, you must clear content related to connector resource bundles 
from the server cache.

To clear content related to connector resource bundles from the server cache:

1. In a command window, change to the OIM_HOME/xellerate/bin directory.

2. Enter one of the following commands:

■ On Microsoft Windows:

PurgeCache.bat ConnectorResourceBundle

■ On UNIX:

PurgeCache.sh ConnectorResourceBundle

Note: While installing Oracle Identity Manager in a clustered 
environment, you copy the contents of the installation directory to 
each node of the cluster. Similarly, you must copy all the JAR files and 
the contents of the connectorResources directory to the 
corresponding directories on each node of the cluster.

Note: In a clustered environment, you must perform these 
procedures on each node of the cluster.

Note: You must perform Step 1 before you perform Step 2. An 
exception is thrown if you run the command described in Step 2 as 
follows:

OIM_HOME/xellerate/bin/script_file_name
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In this command, ConnectorResourceBundle is one of the content categories 
that you can remove from the server cache. Refer to the following file for 
information about the other content categories:

OIM_HOME/xellerate/config/xlconfig.xml

Enabling Logging
When you enable logging, Oracle Identity Manager automatically stores in a log file 
information about events that occur during the course of provisioning and 
reconciliation operations. To specify the type of event for which you want logging to 
take place, you can set the log level to one of the following:

■ ALL

This level enables logging for all events.

■ DEBUG 

This level enables logging of information about fine-grained events that are useful 
for debugging.

■ INFO

This level enables logging of messages that highlight the progress of the 
application at a coarse-grained level.

■ WARN

This level enables logging of information about potentially harmful situations.

■ ERROR

This level enables logging of information about error events that may allow the 
application to continue running.

■ FATAL

This level enables logging of information about very severe error events that could 
cause the application to stop functioning.

■ OFF

This level disables logging for all events.

The file in which you set the log level depends on the application server that you use:

■ BEA WebLogic

To enable logging:

1. Add the following line in the 
OIM_HOME/xellerate/config/log.properties file:

log4j.logger.ADAPTER.PSFTEMPLOYEE=log_level
log4j.logger.com.thortech.xl.integration.peoplesoft.PeopleSoftAction=log_le
vel
log4j.logger.com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliati
on=log_level

2. In these lines, replace log_level with the log level that you want to set.

Note: You can ignore the exception that is thrown when you perform 
Step 2. This exception is different from the one mentioned in Step 1.
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For example:

log4j.logger.ADAPTER.PSFTEMPLOYEE=DEBUG
log4j.logger.com.thortech.xl.integration.peoplesoft.PeopleSoftAction=DEBUG
log4j.logger.com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliati
on=DEBUG

After you enable logging, log information is written to the following file:

WEBLOGIC_HOME/user_projects/domains/domain_name/server_name/server_name.log

■ IBM WebSphere

To enable logging:

1. Add the following line in the 
OIM_HOME/xellerate/config/log.properties file:

log4j.logger.ADAPTER.PSFTEMPLOYEE=log_level
log4j.logger.com.thortech.xl.integration.peoplesoft.PeopleSoftAction=log_le
vel
log4j.logger.com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliati
on=log_level

2. In these lines, replace log_level with the log level that you want to set.

For example:

log4j.logger.ADAPTER.PSFTEMPLOYEE=DEBUG
log4j.logger.com.thortech.xl.integration.peoplesoft.PeopleSoftAction=DEBUG
log4j.logger.com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliati
on=DEBUG

After you enable logging, log information is written to the following file:

WEBSPHERE_HOME/AppServer/logs/server_name/SystemOut.log

■ JBoss Application Server

To enable logging:

1. In the JBOSS_HOME/server/default/conf/log4j.xml file, locate the 
following lines:

<category name="ADAPTER.PSFTEMPLOYEE">
   <priority value="log_level"/>
</category>

<category name="com.thortech.xl.integration.peoplesoft.PeopleSoftAction">
   <priority value="log_level"/>
</category>

<category 
name="com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliation">
   <priority value="log_level"/>
</category>

2. In these lines, replace log_level with the log level that you want to set. For 
example:

<category name="ADAPTER.PSFTEMPLOYEE">
   <priority value="DEBUG"/>
</category>
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<category name="com.thortech.xl.integration.peoplesoft.PeopleSoftAction">
   <priority value="DEBUG"/>
</category>

<category 
name="com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliation">
   <priority value="DEBUG"/>
</category>

After you enable logging, log information is written to the following file:

JBOSS_HOME/server/default/log/server.log

■ Oracle Application Server

To enable logging:

1. Add the following line in the 
OIM_HOME/xellerate/config/log.properties file:

log4j.logger.ADAPTER.PSFTEMPLOYEE=log_level
log4j.logger.com.thortech.xl.Integration.peoplesoft.PeopleSoftAction=log_le
vel
log4j.logger.com.thortech.xl.Integration.peoplesoft.util.tcUtilReconciliati
on=log_level

2. In these lines, replace log_level with the log level that you want to set.

For example:

log4j.logger.ADAPTER.PSFTEMPLOYEE=DEBUG
log4j.logger.com.thortech.xl.integration.peoplesoft.PeopleSoftAction=DEBUG
log4j.logger.com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliati
on=DEBUG

After you enable logging, log information is written to the following file:

OAS_HOME/opmn/logs/default_group~home~default_group~1.log

Step 4: Importing the Connector XML Files
To import the connector XML files into Oracle Identity Manager:

1. Open the Oracle Identity Manager Administrative and User Console.

2. Click the Deployment Management link on the left navigation bar.

3. Click the Import link under Deployment Management. A dialog box for opening 
files is displayed.

4. Locate and open the adpPSFT_RECON_DM.xml file, which is in the 
OIM_HOME/xlclient directory. Details of the XML file are shown on the File 
Review page.

5. Click Add File. The Substitutions page is displayed.

6. Click Next. The Confirmation page is displayed.

7. Click Next. The Provide IT Resource Instance Data page for the PSFT_Employee 
IT resource is displayed.

8. Specify values for the parameters of the PSFT_Employee IT resource. The 
following table lists the values to be specified:



Step 4: Importing the Connector XML Files

Deploying the Connector 2-7

9. Click Next. The Provide IT Resource Instance Data page for a new instance of the 
PSFT_Employee IT resource type is displayed.

10. Click Skip to specify that you do not want to define another IT resource. The 
Confirmation page is displayed.

11. Click View Selections.

The contents of the XML file are displayed on the Import page. You may see a 
cross-shaped icon along with some nodes. These nodes represent Oracle Identity 
Manager entities that are redundant. Before you import the connector XML file, 
you must remove these entities by right-clicking each node and then selecting 
Remove.

12. Click Import. The connector file is imported into Oracle Identity Manager.

13. To import the adpPSFT_XellerateUser_RECON_DM.xml file, perform Steps 2 
through 7 and Steps 9 through 12. Do not perform Step 8.

Parameter Description

NumberOfRetries Use this parameter to specify the number of times Oracle Identity Manager 
must try connecting to the target system before the 
InvocationTargetException is thrown.

Default value: 2

DelayBetweenRetries Use this parameter to specify the time difference between consecutive retries 
(in milliseconds).

Default value: 20000

IndexOfLastReconciledReco
rd

This parameter stores the index of the last successful reconciled record. This 
parameter is applicable only for full reconciliation. Refer to the "Configuring 
the IndexOfLastReconciledRecord Parameter" section on page 3-21 for more 
information about this parameter.

Default value: -1

See Also: If you want to define another IT resource, then refer to 
Oracle Identity Manager Administrative and User Console Guide for 
instructions.

Note: The default name of the IT resource provided in the connector 
xml file is PSFT_Employee. This name is hardcoded in the 
incremental reconciliation code for PeopleTools 8.22. This IT resource 
name must not be changed for incremental reconciliation to be run 
successfully.

Caution: Only one target system can be designated as a trusted 
source. By importing the 
adpPSFT_XellerateUser_RECON_DM.xml file, you configure 
trusted source reconciliation. If you import this XML file while you 
have another trusted source configured, then both connector 
reconciliations would stop working.
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3
Configuring the Target System and Oracle

Identity Manager

This chapter discusses the following topics:

■ Configuring the Target System

■ Configuring Oracle Identity Manager

Configuring the Target System
This section discusses the following topics:

■ Configuring the Target System for Full Reconciliation

■ Configuring the Target System for Incremental Reconciliation

Configuring the Target System for Full Reconciliation
As described in Chapter 1, "About the Connector", full reconciliation is used to 
reconcile all the data in the target system into Oracle Identity Manager. The 
PeopleCode that is activated extracts the required employee information through 
certain components that are applicable, such as PERSONAL_DATA, JOB_DATA, and 
JOB_DATA_EMP. 

Configuring the target system for full reconciliation involves preparing the flat file for 
full reconciliation by performing the following procedures:

1. Creating the Application Engine Program

You have to create the Application Engine program only once when you are 
perform full reconciliation for the first time.

2. Running the Application Engine Program

You must run the Application Engine program each time you want to perform full 
reconciliation.

Note: This section provides both conceptual and procedural 
information about configuring the connector. Oracle recommends that 
you read the conceptual information before you perform the 
procedures.
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Creating the Application Engine Program
The Application Engine program populates the flat file used to perform full 
reconciliation with employee information that requires reconciliation. To create the 
Application Engine program:

1. To open Application Designer in 2-tier mode, click Start, Programs, Peoplesoft8.x, 
and then Application Designer.

2. Select New from the File menu.

3. In the New Definition dialog box, select App Engine Program from the Definition 
list.

4. On the App Engine Program page, a plus sign (+) is displayed before the MAIN 
section in the Application Engine program under which there may be multiple 
steps. In each step, there may be some PeopleCode to be run. Click the plus sign 
(+). A step titled Step01 is added to MAIN.

5. Rename Step01 to Populate.

6. In the App Engine Program window, select Action from the Insert menu. An 
action is added to the Populate step.

7. Select PeopleCode from the list for the new action. 

8. Click Save from the File menu to save the Application Engine program with the 
name BLKPRCS_HR.

9. Double-click the PeopleCode action. A new PeopleCode window is displayed.

10. In the PeopleCode window, copy the code from the   
OIM_HOME/xellerate/Scripts/HRMSBulkRecon.txt file. You must make 
the following changes in this code:

■ Modify the <ABSOLUTE_PATH_OF_THE_FILE> placeholder with the 
directory path for the output file. Change the sample directory path to a 
directory path on the target system server.

■ The code written to fetch the values of BIRTHDATE and HIREDATE is specific 
to Oracle Database. Therefore, depending on the database that Peoplesoft is 
running on, you may need to make changes in the code that you copy from the 
HRMSBulkRecon.txt file. For example:

If you are running Peoplesoft on Microsoft SQL Server, then

– Replace TO_CHAR(BIRTHDATE, 'ddmmyy') with convert 
(varchar, BIRTHDATE, 104)

– Replace TO_CHAR(HIRE_DT, 'ddmmyy') with convert (varchar, 
HIRE_DT, 104)

If you are running Peoplesoft on Sybase, then

– Replace TO_CHAR(BIRTHDATE, 'ddmmyy') with convert 
(char(6), BIRTHDATE, 12)

– Replace TO_CHAR(HIRE_DT, 'ddmmyy') with convert (char(6), 
HIRE_DT, 12)

If you are running Peoplesoft on Informix, then

– Replace TO_CHAR(BIRTHDATE, 'ddmmyy') with TO_CHAR 
(BIRTHDATE, " | """%d %m %y""" | ")
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– Replace TO_CHAR(HIRE_DT, 'ddmmyy') with TO_CHAR(HIRE_DT, " 
| """%d %m %y""" | ")

11. If the PeopleSoft server is running on Microsoft SQL Server, then you may need to 
change the value of the XelServerDate property in the following file:

OIM_HOME/xellerate/XLIntegrations/PSFTHR/config/configureReconciliation.propert
ies

Set the value of this property to the following:

dd.mm.yy

If PeopleSoft server is running on Oracle Database, then you need not change the 
value of the XelServerDate property.

12. Save the Application Engine program and close the window.

Running the Application Engine Program
The procedure to run the Application Engine program depends on the release of 
PeopleTools that you are using:

■ Running the Application Engine Program on PeopleTools 8.22

■ Running the Application Engine Program on PeopleTools 8.45 Through 8.48

Running the Application Engine Program on PeopleTools 8.22
To run the Application Engine program on PeopleTools 8.22:

1. Log in to PeopleSoft Internet Architecture.

2. Click People Tools, Process Scheduler Manager, Use, and Process Definitions.

3. On the Process Definitions page, click Add a New value.

4. Select Application Engine from the Process Type list.

5. Enter the name of the Application Engine program as the process name, 
BLKPRCS_HR. 

6. Click Add. 

7. Select the Application Engine program from the search results that are displayed 
when you click Add.

8. On the Process Definition Options tab, specify the following values:

■ Run Location: Server

■ Server Name: PSNT

■ Component: PRCSMULTI

■ Process Groups: ALLPANLS

9. Click Save.

10. Return to the home page.

11. Click People Tools, Process Scheduler Manager, Process, and Sample Processes.

12. On the Sample Processes page, click Add a New value.

13. Specify a run control ID, and then click Add.
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14. Click Run.

15. On the Process Scheduler Request page, specify the server name.

16. Select the Application Engine program name, and then click OK.

17. Click Process Monitor to verify the status of the process.

After the process status changes to Success, the comma-separated flat file is 
created at the location specified in the code that you copy from the 
HRMSBulkRecon.txt file.

Running the Application Engine Program on PeopleTools 8.45 Through 8.48

To run the Application Engine program on PeopleTools 8.45 through 8.48:

1. Click Start, Programs, Peoplesoft8.x, and then Application Designer. The 
Application Designer window is displayed in 2-tier mode.

2. Specify the connection type, user ID, and password.

3. To open the Application Engine program that you create:

a. From the File menu, select Open and then select Application Engine Program 
from the Object Type list.

b. Select BLKPRCS_HR, and then click Open.

4. Click the RUN PROGRAM control on the toolbar below the menu bar. The 
comma-separated flat file containing employee records is created at the location 
specified in the code that you copy from the HRMSBulkRecon.txt file.

Configuring the Target System for Incremental Reconciliation
Configuring the target system for incremental reconciliation involves creating 
messages and message channels, publishing messages by writing PeopleCode that is 
used to populate and send messages from PeopleSoft Integration Broker to other 
systems, and configuring Integration Broker.

A message is the physical container for the XML data that is sent from PeopleSoft 
Enterprise Applications. Message definitions provide the physical description of data 
that is sent from PeopleSoft Enterprise Applications. This data includes fields, field 
types, and field lengths. A message channel is used to carry messages. It is a 

Note: A run control ID is used as a key for records that contain the 
parameters required by a process at run time. If the parameters are 
stored in a table that the process can query using the run control ID 
and user ID, then the process can run without user intervention.

Note: For the Application Engine program to run in 2-tier mode, the 
database client must be installed on the server used for accessing the 
application designer. To switch to the 2-tier mode, you select 
Connection Type as the database on the PeopleSoft sign-on screen. 

Note: In PeopleTools 8.48 and HCM 9.0, queues replace message 
channels.
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mechanism for structuring data into logical groups. Each message can belong to only 
one message channel.

After messages are created and associated with their respective message channels, you 
must publish the messages, which involves writing the PeopleCode in the application 
designer. This is because PeopleSoft Integration Broker and Oracle Identity Manager 
communicate through the exchange of XML messages and a message can only be 
started by using specific instructions in the PeopleCode.

Setting the PeopleSoft Integration Broker gateway is mandatory when you configure 
PeopleSoft Integration Broker. To subscribe to XML data, Oracle Identity Manager can 
accept and process XML messages posted by PeopleSoft by using PeopleSoft 
connectors located in the PeopleSoft Integration Broker gateway. These connectors are 
Java programs that are controlled by the PeopleSoft Integration Broker gateway and, 
in turn, control the location of the XML files.

This gateway is a program that runs on the PeopleSoft Web server. It acts as a physical 
hub between PeopleSoft and other PeopleSoft applications (or third-party systems, 
such as Oracle Identity Manager). The gateway manages the receipt and delivery of 
messages passed among systems through PeopleSoft Integration Broker.

To configure the target system for incremental reconciliation, you must perform the 
following procedures:

1. Creating the Message Channel

2. Creating the Message

3. Publishing the Message

4. Configuring PeopleSoft Integration Broker

Creating the Message Channel
The procedure to create a message channel varies depending on the version of the 
target system that you are using:

■ Creating the Message Channel on PeopleSoft HRMS 8.3 SP1

■ Creating the Message Channel on PeopleSoft HRMS 8.9

■ Creating the Queue on PeopleSoft HCM 9.0

Creating the Message Channel on PeopleSoft HRMS 8.3 SP1  To create the message channel 
on PeopleSoft HRMS 8.3 SP1: 

1. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed in the 2-tier mode.

2. Select New from the File menu.

Note: The procedures to create messages, message channels, and 
publishing messages depend on the version of the target system being 
used. The procedure to configure PeopleSoft Integration Broker 
depends on the version of PeopleTools being used.

Note: You must use an administrator account to perform the 
following procedures.
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3. In the New Definition dialog box, select Message Channel, and then click OK.

4. Save the new message channel as PERSON_BASIC.

5. Select Definition Properties from the File menu.

6. In the Message Channel Properties dialog box, select the Run option, and then 
select Archive Messages.

7. Click OK, and then save the message.

Creating the Message Channel on PeopleSoft HRMS 8.9  To create the message channel on 
PeopleSoft HRMS 8.9: 

1. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed in the 2-tier mode.

2. Select New from the File menu.

3. In the New Definition dialog box, select Message Channel, and then click OK.

4. Save the new message channel as PERSON_BASIC.

5. Select Object Properties from the File menu.

6. In the Message Channel Properties dialog box, select the Use tab, select the Run 
option, and then select Archive Messages check box.

7. Click OK, and then save the message channel.

Creating the Queue on PeopleSoft HCM 9.0  To create the queue on PeopleSoft HCM 9.0:

1. In the PeopleSoft Internet Architecture window, expand People Tools, Integration 
Broker, and Integration Setup, and then click Queue.

2. On the Add a New Value tab, enter the queue name, for example, 
PSFT_HR_QUEUE, and then click Add.

3. On the Queue Definition tab, select the archive check box.

4. Select Run from the Queue Status list.

5. Click Save to save the changes.

Creating the Message
The procedure to create a message varies depending on the version of the target 
system that you are using:

■ Creating the Message on PeopleSoft HRMS 8.3 SP1

■ Creating the Message on PeopleSoft HRMS 8.9

■ Creating the Message on PeopleSoft HCM 9.0

Creating the Message on PeopleSoft HRMS 8.3 SP1  To create the message on PeopleSoft 
HRMS 8.3 SP1:

1. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed.

2. Select New from the File menu. 

3. In the New Definition dialog box, select Message from the list, and then click OK.

4. Select Definition Properties from the File menu.

5. In the Message Properties dialog box, click the Use tab.
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6. On the Use tab, select the PERSON_BASIC message channel and the version of 
the message that you create from the Version list. By doing this, you associate the 
message with the message channel created in the "Creating the Message Channel 
on PeopleSoft HRMS 8.3 SP1" section on page 3-5.

7. Select Active to make the message an active message, and then click OK.

8. Right-click VERSION_1, and select the Insert Child Record option.

9. In the Insert Record window, enter PERSONAL_DATA in the Name field, click 
Insert, and then click Close.

10. Click PERSONAL_DATA under VERSION_1. All the fields that constitute the 
PERSONAL_DATA records are displayed.

By default, all the fields are selected. Deselect the check boxes for the fields that 
are not required for the message XML file to be generated. Refer to the 
OIM_HOME/xellerate/XLIntegrations/PSFTHR/cbrecon/psft_xellera
te_msg.xml file for information about the fields in the message XML file.

11. Repeat Steps 8 through 10 for the PS_PERS_NID, EMPLOYMENT, and JOB records.

12. Save the message as PSFT_XELLERATE_MSG.

Creating the Message on PeopleSoft HRMS 8.9  To create the message on PeopleSoft HRMS 
8.9:

1. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed.

2. Select New from the File menu. 

3. In the New Definition dialog box, select Message from the list and then click OK.

4. Select Object Properties from the File menu.

5. In the Message Properties dialog box, click the Use tab.

6. On the Use tab, select the PERSON_BASIC message channel and the version of the 
message that you create in Step 2 of this procedure. By doing this, you associate 
the message with the message channel created in the "Creating the Message 
Channel on PeopleSoft HRMS 8.9" section on page 3-6.

7. Select Active to make the message an active message and then click OK to close 
the dialog box.

8. Save the message as PSFT_XELLERATE_MSG. 

You can also save this message with a name of your choice. If you do so, then you 
must make the same change in the code that you copy from the 
HRMSCBRecon.txt file while performing the procedure described in the 
"Publishing the Message on PeopleSoft HRMS 8.9 or HCM 9.0" section on 
page 3-9.

Creating the Message on PeopleSoft HCM 9.0  To create the message on PeopleSoft HCM 
9.0:

1. In the PeopleSoft Internet Architecture window, expand People Tools, Integration 
Broker, and Integration Setup, and then click Message.

2. On the Add a New Value tab, enter the message name, for example, 
PSFT_XELLERATE_MSG. In addition, enter the version in the Version field. The 
valid values for this field are version_1 or v1.

3. Click Add.
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4. On the Message Definition tab, select Nonrowset-based as the message type.

5. Click Save to save the changes.

Publishing the Message
The procedure to publish the message depends on the target system version that you 
are using:

■ Publishing the Message on PeopleSoft HRMS 8.3 SP1

■ Publishing the Message on PeopleSoft HRMS 8.9 or HCM 9.0

Publishing the Message on PeopleSoft HRMS 8.3 SP1  To publish the message on PeopleSoft 
HRMS 8.3 SP1:

1. Click Start, Programs, Peoplesoft8.x, and then Application Designer. The 
Application Designer window is displayed in 2-tier mode.

2. Select Open from the File menu. The Open Definition dialog box is displayed.

3. Select Component from the Definition list, enter PERSONAL_DATA in the Name 
Selection Criteria field, and then click Enter. All component names starting with 
the text PERSONAL_DATA are displayed.

4. Select PERSONAL_DATA from the list, and then click Open. The details of the 
PERSONAL_DATA component are displayed.

5. Click the Structure tab, right-click PERSONAL_DATA, and then select View 
PeopleCode. The PeopleCode for the PERSONAL_DATA component is displayed.

6. Select the SavePostChange event from the list in the upper-right corner of the 
window. The PeopleCode for this event is displayed.

7. Copy the code given in the following file immediately after the import definitions 
in the PeopleCode for the SavePostChange event:

For PeopleTools 8.22:

OIM_HOME/xellerate/Scripts/HRMSCBRecon.txt

For PeopleTools 8.45 through 8.47:

OIM_HOME/xellerate/Scripts/HRMSCBRecon_8.45-8.47.txt

For PeopleTools 8.48:

OIM_HOME/xellerate/Scripts/HRMSCBRecon-8.48.txt

Note: To run the Application Designer in 2-tier mode, you must have 
the database client, which is the client of the database that PeopleSoft 
is using, installed on the server. In addition, you must select the 
appropriate database type from the Connection Type field (for 
example, Oracle Database) while providing sign-on information in the 
PeopleSoft Application Designer Signon window.
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The code written to fetch the values of BIRTHDATE and HIREDATE is specific to 
Oracle Database. You must modify this code based on the database you are using. 
For example:

If you are running Peoplesoft on Microsoft SQL Server, then

– Replace TO_CHAR(BIRTHDATE, 'ddmmyy') with convert (varchar, 
BIRTHDATE, 104)

– Replace TO_CHAR(HIRE_DT, 'ddmmyy') with convert (varchar, 
HIRE_DT, 104)

If you are running Peoplesoft on Sybase, then

– Replace TO_CHAR(BIRTHDATE, 'ddmmyy') with convert (char(6), 
BIRTHDATE, 12)

– Replace TO_CHAR(HIRE_DT, 'ddmmyy') with convert (char(6), 
HIRE_DT, 12)

If you are running Peoplesoft on Informix, then

– Replace TO_CHAR(BIRTHDATE, 'ddmmyy') with TO_CHAR (BIRTHDATE, 
" | """%d %m %y""" | ")

– Replace TO_CHAR(HIRE_DT, 'ddmmyy') with TO_CHAR(HIRE_DT, " | 
"""%d %m %y""" | ")

8. Select Save from the File menu to save the changes to the PERSONAL_DATA 
component.

You must repeat Steps 2 through 8 if you want to publish messages on the 
following components also:

■ JOB_DATA

■ JOB_DATA_HIRE

Publishing the Message on PeopleSoft HRMS 8.9 or HCM 9.0  To publish the message on 
PeopleSoft HRMS 8.9 or HCM 9.0:

1. Click Start, Programs, Peoplesoft8.x, and then Application Designer. The 
Application Designer window is displayed in 2-tier mode

2. Select Open from the File menu. The Open Definition dialog box is displayed.

Note: While creating the message by following the procedure 
described in the "Creating the Message on PeopleSoft HRMS 8.3 SP1" 
section on page 3-6, if you change the name of the message to 
something other than PSFT_XELLERATE_MSG, then you must use the 
same name in the code that you copy.

Note: To run the Application Designer in 2-tier mode, you must have 
the database client, which is the client of the database that PeopleSoft 
is using, installed on the server. In addition, you must select the 
appropriate database type from the Connection Type field (for 
example, Oracle Database) while providing sign-on information in the 
PeopleSoft Application Designer Signon window.
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3. Select Component from the Definition list, enter PERSONAL_DATA in the Name 
Selection Criteria field, and then press Enter. All component names starting with 
the text PERSONAL_DATA are displayed. 

4. Select PERSONAL_DATA from the list, and then click Open. The details of the 
PERSONAL_DATA component are displayed.

5. Click the Structure tab, right-click PERSONAL_DATA, and then select View 
PeopleCode. The PeopleCode for the PERSONAL_DATA component is displayed.

6. Select the SavePostChange event from the list in the upper-left corner of the 
window. The PeopleCode for this event is displayed.

7. Copy the code given in the following file immediately after the import definitions 
in the PeopleCode for the SavePostChange event:

OIM_HOME/xellerate/Scripts/HRMSCBRecon.txt

The code written to fetch the values of BIRTHDATE and HIREDATE is specific to 
Oracle Database. You must modify this code based on the database you are using. 
For example:

If you are running Peoplesoft on Microsoft SQL Server, then

– Replace TO_CHAR(BIRTHDATE, 'ddmmyy') with convert (varchar, 
BIRTHDATE, 104)

– Replace TO_CHAR(HIRE_DT, 'ddmmyy') with convert (varchar, 
HIRE_DT, 104)

If you are running Peoplesoft on Sybase, then

– Replace TO_CHAR(BIRTHDATE, 'ddmmyy') with convert (char(6), 
BIRTHDATE, 12)

– Replace TO_CHAR(HIRE_DT, 'ddmmyy') with convert (char(6), 
HIRE_DT, 12)

If you are running Peoplesoft on Informix, then

– Replace TO_CHAR(BIRTHDATE, 'ddmmyy') with TO_CHAR (BIRTHDATE, 
" | """%d %m %y""" | ")

– Replace TO_CHAR(HIRE_DT, 'ddmmyy') with TO_CHAR(HIRE_DT, " | 
"""%d %m %y""" | ")

8. Select Save from the File menu to save the changes to the PERSONAL_DATA 
component.

9. Add the following function call code at the end of the PeopleCode for the 
SavePostChange event:

/**********************************************************************/

Note: While creating the message by following the procedure 
described in the "Creating the Message on PeopleSoft HRMS 8.9" 
section on page 3-7, if you change the name of the message to 
something other than PSFT_XELLERATE_MSG, then you must use the 
same name in the code that you copy.

Note: Perform this step after you copy the code. 
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/*  Calling the Generate function to generate the 
PSFT_XELLERATE_MSG message*/
/**********************************************************************/
Local string &emplid;
&emplid = PERSON.EMPLID;
GENERATE(&emplid);

10. To save the changes to the component that you created in Step 5, select Save from 
the File menu.

You must repeat Steps 2 through 10 if you want to publish messages on the 
following components also:

■ JOB_DATA

■ JOB_DATA_EMP

Configuring PeopleSoft Integration Broker
The procedure to configure PeopleSoft Integration Broker depends on the release of 
PeopleTools that you are using.

The following section explains the procedure to configure PeopleSoft Integration 
Broker on PeopleTools 8.22:

■ Configuring PeopleSoft Integration Broker on PeopleTools 8.22

The following sections explain the procedures to configure PeopleSoft Integration 
Broker on PeopleTools 8.45 through 8.47 and PeopleTools 8.48:

■ Configuring PeopleSoft Integration Broker Gateway on PeopleTools 8.45 Through 
8.48

■ Configuring PeopleSoft Integration Broker on PeopleTools 8.45 Through 8.47

■ Configuring PeopleSoft Integration Broker on PeopleTools 8.48

Configuring PeopleSoft Integration Broker on PeopleTools 8.22  To configure PeopleSoft 
Integration Broker on PeopleTools 8.22:

1. To create the XL_NODE remote node:

a. In the Application Designer, select New from the File menu.

b. In the New Definition dialog box, select Message Node from the list, and then 
click OK.

Note: While configuring PeopleSoft Integration Broker, you perform 
some of the procedures in PeopleSoft Internet Architecture and some 
in the Application Designer. For example, for PeopleTools 8.22 and 
PeopleTools 8.45 through 8.47, some of the configuration steps must 
be performed in PeopleSoft Internet Architecture and some in the 
Application Designer. For PeopleTools 8.48, all of the configuration 
steps must be performed in PeopleSoft Internet Architecture.

Note: Configuring the PeopleSoft Integration Broker gateway is a 
part of the procedure to configure the PeopleSoft Integration Broker 
on PeopleTools 8.22.
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c. Right-click anywhere in the white space, and then select Insert Location. The 
Location dialog box is displayed.

d. Enter the URL for the PeopleSoft Integration Broker gateway in the following 
format:

http://hostname:port/servlets/gateway

In this URL, hostname is the application server that hosts PeopleSoft and 
port is the port number at which the application server is listening.

e. Select Object Properties from the File menu.

f. In the Message Node Properties dialog box, select the Use tab. Ensure that 
Local Node is not selected.

g. Save the remote node as XL_NODE.

2. To configure the PERSON_BASIC message channel:

a. From the File menu, select Open and then click Message Channel.

b. To open the PERSON_BASIC message channel, select PERSON_BASIC.

c. Click the Routing Rules tab.

d. Right-click anywhere in the white space, and then select Insert Message 
Node.

e. In the Insert Message Node dialog box, select the XL_NODE message node, 
and then click Insert.

f. Close the dialog box.

g. Right-click the message node displayed on the Routing Rules tab. 

h. Point to Routing Direction, and then select Publish To.

i. Save the message channel.

3. To configure the PeopleSoft Integration Broker gateway so that messages can be 
sent through the gateway to Oracle Identity Manager:

a. In a Web browser, use a URL with the following format to open the Handler 
Directory page (configuration window for the PeopleSoft Integration Broker 
gateway):

http://hostname:port/servlets/gateway.administration

For example:

http://10.121.16.42:8080/peopleSoftApp/do/peopleSoftAction

In this URL, hostname is the application server that hosts PeopleSoft and 
port is the port number at which the application server is listening.

b. Click Add Handler.

Note: The Simple File Handler mentioned in this procedure is a 
utility in PeopleTools 8.22 that can receive messages published by a 
PeopleSoft node and write these messages to a file that can be used by 
third-party systems.
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c. On the Add Handler page, enter the full name of the Simple File Handler 
class, psft.pt8.filehandler.SimpleFileHandler.

d. Click Save.

e. To load the handler, on the Handler Directory page, click Load.

After the handler is loaded, the "Loaded successfully" message is displayed in 
the Status column.

f. Click Configure.

g. Click Add a file handler node.

h. In the Node Name field on the Add File Handler Node page, enter the name 
of the message node that you create, XL_NODE.

i. Specify the output directory in which the published messages are to be stored.

j. Select Include Header.

k. Click Save.

4. XML messages are generated by the PeopleTools 8.22 Simple File Handler. To 
publish these messages to the PeopleSoft connector, create a Microsoft Windows 
scheduled task as follows. You must create the scheduled task on the computer on 
which the PeopleSoft Web server is running.

a. Copy the xliMsgPublisher.jar and publish.bat files from the 
OIM_HOME/xellerate/lib/MsgPublisher directory to a directory on the 
target system server.

b. Use a text editor to open the publish.bat file, and then make the following 
changes in the file:

i. Change the value of the JAVA_HOME variable so that it points to the JDK 
installation directory on the computer on which the PeopleSoft Web server is 
running.

ii. Specify the following values in the Java command given at the end of the 
file:

- PeopleSoft_listener_servlet_URL: This is the URL of the servlet 
that listens for reconciliation events generated using PeopleSoft Application 
Messaging.

- Output_directory_for_XML_messages: This is the PeopleSoft Web 
server directory in which you want published messages to be stored. You have 
already specified the output directory while performing Step 3.i of this 
procedure.

Note: The Microsoft Windows scheduled task calls a Java program 
that communicates with a servlet deployed on the Oracle Identity 
Manager server. The servlet parses the message and sends 
reconciliation events to Oracle Identity Manager.

The servlet sends a return code based on the status of the 
reconciliation event. If the reconciliation event is successfully sent, 
then the message file is deleted or archived. Otherwise, the message 
file is left unchanged. The next time the scheduled task is run, another 
attempt is made to send the message.
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- XML_message_name: This is the message name created while configuring 
the target. Refer to the "Creating the Message" section on page 3-6 for more 
information.

- console_log_file_path: This is the full path and the name of the 
directory in which the log file must be generated.

The command is in the following format:

java com.thortech.xl.Integration.msgpublisher.PeopleSoftPublisher 
"PeopleSoft_listener_servlet_URL" "Output_directory_for_XML_messages" 
XML_message_name >> console_log_file_path

For example:

java Com.thortech.xl.Integration.msgpublisher.PeopleSoftPublisher 
"http://host:port/peopleSoftApp/do/peopleSoftAction" "C:/test/file" 
PSFT_XELLERATE_MSG >> c:/test/consolelog.log

In the PeopleSoft listener servlet URL specified in this example, hostname is 
the IP address or host name of the application server on which Oracle Identity 
Manager is running and port is the HTTP port at which the application 
server listens for incoming messages.

c. Save and close the batch file.

d. On the On the computer on which the PeopleSoft Web server is running, click 
Start, Settings, and Control Open.

e. Double-click Scheduled Tasks.

f. Click Add Schedule Task, and then click Next.

g. Click Browse, and then select the publish.bat file from the directory in 
which you save it.

h. Select Daily, click Next, and then click Next again.

i. Enter the user ID and password for the scheduled task to run.

j. Select Open Advance properties.

k. Click Finish.

l. On the Schedule tab, click Advanced.

m. Select Repeat Task.

n. Select the frequency at which you want the task to run.

o. Click OK, and then click OK again to close the window.

Configuring PeopleSoft Integration Broker Gateway on PeopleTools 8.45 Through 8.48  To 
configure the PeopleSoft Integration Broker gateway on PeopleTools 8.45 through 8.48:

1. Open a Web browser and enter the URL for PeopleSoft Internet Architecture. The 
URL for PeopleSoft Internet Architecture is in the following format:

http://servername/psp/ps/Databasename/?cmd=login

For example:

http://psftserver.acme.com/psp/ps/TestDB/?cmd=login

2. Expand PeopleTools, Integration Broker, Configuration, and then Gateways. The 
Gateway component details are displayed.
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3. Enter LOCAL in the Integration Gateway ID field, and then click Search. The 
LOCAL gateway is a default gateway that is created when you install PIA.

4. Ensure that the IP address specified in the URL of the PeopleSoft listening 
connector is the IP address of the computer on which the target system is installed. 
The URL of the PeopleSoft listening connector is in the following format:

http://computer_name_of_the_PeopleSoft_Web_server/IP 
address:port/PSIGW/PeopleSoftListeningConnector

For example:

http://10.121.16.42:80/PSIGW/PeopleSoftListeningConnector

5. To load all target connectors that are registered with the LOCAL gateway, click 
Load Gateway Connectors.

6. Click Save.

7. Click Ping Gateway to check if the gateway component is active.

Configuring PeopleSoft Integration Broker on PeopleTools 8.45 Through 8.47  To configure 
PeopleSoft Integration Broker on PeopleTools 8.45 through 8.47:

To create the XL_NODE node to serve as the remote node:

1. In the PIA window, expand PeopleTools, Integration Broker, Integration Setup, 
and then click Node Definitions.

2. Click the Add a New Value tab.

3. On the Add a New Value tab, enter XL_NODE as the node name and then click 
Add.

4. On the Node Definition tab, enter a description for the node in the Description 
field.

5. Make this node a remote node by deselecting the Local Node check box and 
selecting the Active Node check box.

6. On the Connectors tab, enter the following information and then perform a 
lookup:

Gateway ID: LOCAL

Connector ID: HTTPTARGET

7. On the Properties subpage in the Connectors tab, enter the following information:

Property ID: HTTPTARGET

Property Name: URL

Required value: Enter the URL of the PeopleSoft servlet that is supposed to receive 
the XML message. This URL must be in the following format:

http://computer name of the Oracle Identity Manager server/IP 
address:port/peopleSoftApp/do/peopleSoftAction

For example:

http://10.121.16.42:8080/peopleSoftApp/do/peopleSoftAction

8. Click the Ping Node button to check if a connection is established with the 
specified IP address.
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9. On the Transactions tab, click Add Transaction. The Add Transaction dialog box is 
displayed.

10. Enter the following details to define a new transaction:

Transaction Type: Outbound Asynchronous

Request Message: PSFT_XELLERATE_MSG

Request Message Version: VERSION_1

11. Click Add.

12. To keep the status as active, select Active.

13. Click Save to save the changes.

To secure the PERSON_BASIC message channel:

1. In PIA, expand PeopleTools, Security, Permission & Roles, and Permission Lists.

2. Select AEAE1000. The AEAE1000 permission list is displayed.

3. Select the Message Monitor tab, and then click the plus sign (+) to add a channel 
name.

4. Specify PERSON_BASIC as the channel name, and select FULL as the access 
level.

5. Click Save.

To verify that the PERSON_BASIC message channel is in running mode:

1. Expand PeopleTools, Integration Broker, Monitor Integration, and Monitor 
Message.

2. Click the Channel Status tab.

3. Verify that the PERSON_BASIC message channel is running. If it is paused, then 
click Run.

Configuring PeopleSoft Integration Broker on PeopleTools 8.48  To configure PeopleSoft 
Integration Broker on PeopleTools 8.48:

1. Create a remote node by performing the following steps:

a. In PeopleSoft Internet Architecture, expand PeopleTools, Integration Broker, 
Integration Setup, and then click Nodes.

b. On the Add a New Value tab, enter the node name, for example, HT_NODE, 
and then click Add.

c. On the Node Definition tab, enter a description for the node in the 
Description field. In addition, enter PS in the Default User ID field.

d. Make this node a remote node by deselecting the Local Node check box and 
selecting the Active Node check box.

e. On the Connectors tab, enter the following information:

Gateway ID: LOCAL

Connector ID: HTTPTARGET

f. Click the Ping Node button to check if a connection is established with the 
specified IP address.

g. On the Properties subpage in the Connectors tab, enter the following 
information:
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Property ID: PRIMARYURL

Property Name: URL

Required value: Enter the URL of the PeopleSoft servlet that is supposed to 
receive the XML message. This URL must be in the following format:

http://computer name of the Oracle Identity Manager server/IP 
address:port/peopleSoftApp/do/peopleSoftAction

For example:

http://10.121.16.42:8080/peopleSoftApp/do/peopleSoftAction

h. Click Save to save the changes.

2. Create a service by performing the following steps:

a. In PeopleSoft Internet Architecture, expand PeopleTools, Integration Broker, 
Integration Setup, and then click Service.

b. On the Add a New Value tab, enter the service name, for example, 
PSFT_HR_SERVICE, and then click Add.

c. On the Service Definition tab, enter a description for the service in the 
Description field.

d. Click Save to save the changes.

3. Create a service operation by performing the following steps:

a. In the PeopleSoft Internet Architecture window, expand PeopleTools, 
Integration Broker, Integration Setup, and then click Service Operation.

b. On the Add a New Value tab, enter the service name for which you are 
creating the service operation. In addition, enter the service operation name. 
The name of the service operation must be the same as that of the service that 
you created in Step 2 of the "Creating the Message on PeopleSoft HCM 9.0" 
section on page 3-7, for example, PSFT_HR_SERVICE.

c. From the Operation type list, select Asynchronous-Oneway, and then click 
Add.

d. On the General tab of the Service Operation Definition page, enter a 
description for the Operation type in the Operation Description field. In 
addition, enter PSFT_XELLERATE_MSG.V1 in the Message.Version field and 
PSFT_HR_QUEUE in the Queue Name field.

e. Click Save to save the changes.

f. On the Routing tab, enter PSFT_HR_ROUTING as the routing name and then 
click Add.

g. On the Routing Definition tab, enter PSFT_HR in the Sender Node field and 
PSFT_HR_NODE in the Receiver Node field.

h. Click Save to save the changes.

Before you start sending the XML messages from the target system to Oracle 
Identity Manager, you must verify if the PeopleSoft node is running. You can 
do so by clicking the Ping Node button in the Connectors tab. To access the 
Connectors tab, click PeopleTools, Integration Broker, and then Nodes.

If the Oracle Identity Manager server is not running when a message is 
published, then the message is added to a queue. You can check the status of 
the message in the queue in the Message Instance tab. This tab lists all the 
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published messages in queue. When you check the details of the particular 
message, you will find the status listed as Timeout or Error.

To publish a message in the queue to Oracle Identity Manager, resubmit the 
message when Oracle Identity Manager is running. See "Publishing the 
Message" on page 3-8 for more information.

If the status of the message is New or Started and it does not change to 
Timeout or Done, then you must restart the PeopleSoft application server 
after you restart the Oracle Identity Manager server.

Configuring Oracle Identity Manager
Configuring Oracle Identity Manager for this connector involves configuring 
reconciliation only. As mentioned earlier in this guide, reconciliation involves 
duplicating in Oracle Identity Manager new and modified employee information from 
the target system.

This section discusses the following topics:

■ Configuring Full Reconciliation

■ Configuring Incremental Reconciliation

Configuring Full Reconciliation
This section discusses the following topics:

■ Configuring the Reconciliation Scheduled Tasks

■ Configuring the IndexOfLastReconciledRecord Parameter

■ Adding Custom Attributes for Full Reconciliation

■ Limited Reconciliation

Configuring the Reconciliation Scheduled Tasks
When you perform the procedure described in the "Step 4: Importing the Connector 
XML Files" section on page 2-6, the scheduled task is automatically created in Oracle 
Identity Manager. To perform a full reconciliation run, you must configure the 
scheduled task to reconcile the users in Oracle Identity Manager depending on the 
values that the user has specified in the scheduled task attributes.

To specify values for the attributes of the scheduled task, perform the following:

Note: You can perform a full reconciliation run at any future date or 
time for the following specified intervals:

■ Daily

■ Weekly

■ Monthly

■ Yearly

■ Recurring intervals

Alternatively, you can configure a scheduled task attribute to run once 
on the specified date and time.
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1. Open the Oracle Identity Manager Design Console.

2. Expand the Administration folder.

3. Select Task Scheduler.

4. Click Find, and look for the scheduled task named PSFTHRTrustedUserRecon 
in the Task Scheduler table.

5. Enter a number in the Max Retries field. This number represents the number of 
times Oracle Identity Manager must attempt to complete the task before assigning 
the FAILED status to the task.

6. Ensure that the Disabled and Stop Execution check boxes are not selected.

7. In the Start region, double-click the Start Time field and select the date and time at 
which you want the task to run.

8. To set the task to run only once, select the Once option in the Interval region.

9. Provide values for the attributes of the scheduled task. Refer to the "Specifying 
Values for the Scheduled Task Attributes" section on page 3-19 for information 
about the values to be specified.

10. Click Save. The scheduled task is configured. The INACTIVE status is displayed in 
the Status field, because the task is not currently running. The task is run only at 
the date and time that you specify in Step 7.

After you configure the scheduled task, proceed to the "Configuring Incremental 
Reconciliation" section on page 3-24.

Specifying Values for the Scheduled Task Attributes  The user reconciliation scheduled task 
has been defined as two scheduled tasks, one for trusted employee reconciliation and 
the other for target resource employee reconciliation. However, you must use only the 
scheduled task for trusted employee reconciliation for the target system.

You must specify values for the attributes of the PSFTHRTrustedUserRecon 
employee reconciliation scheduled task. The following table describes the attributes of 
the scheduled task.

Note:

■ Default attribute values are predefined in the connector XML file 
that you import. Specify values only for the attributes that you 
want to change.

■ Values (either default or user-defined) must be assigned to (or 
specified by default for) all the attributes. If even a single attribute 
value were left empty, then reconciliation would not be 
performed.

■ Do not make changes in the scheduled task for target resource 
reconciliation, PSFTHRNonTrustedUserRecon. This scheduled 
task is not meant to be used with this connector.
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Attribute Name Description Sample Value

FolderPath Directory path on the Oracle Identity Manager 
server where employee reconciliation files 
generated by the target system are to be stored

Note: The folder path must contain only the text file 
that is generated when you run the application 
engine. The Task Scheduler searches for text files. 
Therefore, the specified path must only contain the 
file to be read by the Task Scheduler. The value of 
the folder path must end in \.

C:\PSFTHR\UserRecon\

TargetSystem Name of the resource object PSFT_HR_RO

IsTrusted Specifies whether or not reconciliation is to be 
performed in trusted mode. For this connector, only 
trusted source reconciliation is configured. 
Therefore, this attribute value must always be set to 
Yes.

Yes

XellerateOrganization Default name for the Oracle Identity Manager 
organization

This value is used to create the Xellerate User in 
trusted source reconciliation mode. The value that 
you specify must exist in Oracle Identity Manager. 

Note: This attribute is specific to the scheduled task 
for trusted source reconciliation. 

Xellerate Users

NoOfRecordsToBeReconc
iled

Specifies the number of records to be reconciled

You must enter any integer value greater than zero. 
Refer to the "Specifying the Number of Records to 
Be Reconciled" section on page 3-21 for more 
information about this attribute.

Default value: all

Any integer value greater 
than zero

Lastname Specifies the Lastname attribute value for which 
you want to perform reconciliation

During reconciliation, only those target system 
records that contain the Lastname value you 
specify are reconciled. For more information about 
how this reconciliation is performed, refer to the 
"Limited Reconciliation" on page 3-23.

Nodata

Postal Specifies the Postal attribute value for which you 
want to perform reconciliation

During reconciliation, only those target system 
records that contain the Postal value you specify 
are reconciled.

Nodata

DeptId Specifies the DeptId attribute value for which you 
want to perform reconciliation

During reconciliation, only those target system 
records that contain the DeptId value you specify 
are reconciled.

Nodata
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After you specify values for these task attributes, go to Step 10 of the procedure to 
create scheduled tasks.

Specifying the Number of Records to Be Reconciled  During a reconciliation run, all changes 
in the target system records are reconciled into Oracle Identity Manager. Depending 
on the number of records to be reconciled, this process may require a large amount of 
time. In addition, if the connection breaks during reconciliation, then the process 
would take longer to complete.

To reduce the reconciliation time, you can specify the number of records to be 
reconciled. To do this, you specify a value for the NoOfRecordsToBeReconciled 
scheduled task attribute.

You specify a value for the NoOfRecordsToBeReconciled attribute by following 
the instructions described in the "Specifying Values for the Scheduled Task Attributes" 
section on page 3-19.

Configuring the IndexOfLastReconciledRecord Parameter
You specify a value for the IndexOfLastReconciledRecord IT resource parameter 
when you want to perform full reconciliation. At the start of the first full reconciliation 
run, the value of this parameter is -1. At the end of each subsequent full reconciliation 
run, this parameter stores the index number of the last record reconciled during the 
previous reconciliation run.

Whenever you want to perform a full reconciliation run, change the value of the 
IndexOfLastReconciledRecord parameter to -1. To change the value of this 
parameter:

1. Log in to the Oracle Identity Manager Design Console.

2. Expand Resource Management.

3. Double-click IT Resources.

4. Locate the PSFT_Employee  IT resource.

5. Change the value of the IndexOfLastReconciledRecord parameter to -1.

Adding Custom Attributes for Full Reconciliation
To add custom attributes for full reconciliation:

Operator Specifies the operator that you want to apply to the 
target system attributes for which you specify a 
value other than nodata

This operator value can be AND or OR based on 
which the data is joined accordingly for any 
combination of the following fields: Lastname, 
Postal, DeptId.

During reconciliation, only those target system 
records that contain the specified combination of the 
Lastname, Postal, and DeptId fields are 
reconciled.

AND

ServerName Name of the IT resource defined for the PeopleSoft 
application target system.

PSFT_Employee

Attribute Name Description Sample Value
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1. In PeopleSoft Application Designer:

a. Select Open from the File menu. The Open Definition dialog box is displayed.

b. Select Message from the Definition list, enter PSFT_XELLERATE_MSG in the 
Name Selection Criteria field, and then click Enter. The details of the 
PSFT_XELLERATE_MSG message are displayed.

c. Click the record to which you want to add custom attributes.

For example, suppose you want to add the Salary attribute, SALARY, in the 
JOB record, then click JOB under VERSION_1.

d. Select the check box for the required attribute, and then save the message.

For example, select the SALARY field.

2. Modify the header and the queries written in the application engine code 
(BLKPRCS_HR). For example, if you want to reconcile a new column with the 
name SALARY, then you must make the following changes in the application 
engine code:

Local string &empid, &lastnm, &firstnm, &sex, &postal, &city, &ssn, &ph, 
&birthdt, &country, &add1, &state, &hir_dt, &deptid, &jobcd, &salary;

&hdr = 
"EMPLID,LASTNAME,FIRSTNAME,SEX,POSTAL,CITY,SSN,PHONE,BIRTHDATE,COUNTRY,ADDRESS,
STATE,HIRE_DATE,DEPTID,JOBCODE,SALARY";

If the SALARY column exists in the ps_job table, the SQL statement will be:

SQLExec("select DEPTID, JOBCODE, SALARY from ps_job a where emplid =:1 and 
effdt=(select max(effdt) from ps_job b where a.emplid=b.emplid and effseq 
=(select max(effseq) from ps_job c where b.emplid = c.emplid and 
b.effdt=c.effdt))", &empid, &deptid, &jobcd, &salary);

3. Open the process form located in the Development Tools folder of the Oracle 
Identity Manage Design Console.

4. Click Create New Version.

5. In the Create a New Version dialog box, specify the version name in the Label 
field. Save the changes, and then close the dialog box.

6. From the Current Version list, select the newly created version.

7. On the Additional Columns tab, click Add. Add a column corresponding to the 
new attribute in the User Defined process form, UD_PSFT_HR. For the example 
described earlier, you can add the UD_PSFT_HR_SALARY column.

Note: The procedure described in this section is the same for all 
certified versions of PeopleTools. If you do not want to add custom 
attributes for full reconciliation, then you can skip this section.

Note: Step 1 is mandatory if you are using PeopleTools 8.22.

See Also: Oracle Identity Manager Design Console for more 
information about this step and the remaining steps of this procedure
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8. Add a reconciliation field corresponding to the new attribute in the resource 
object, PSFT_HR_RO. For the example described earlier, you can add the 
Users.SALARY reconciliation field.

9. Modify the PSFT_HR process definition to include the mapping between the 
newly added attribute and the corresponding reconciliation field. For the example 
described earlier, the mapping is as follows:

Users.SALARY=UD_PSFT_SALARY

In this example, SALARY is the reconciliation field and also the equivalent target 
system attribute. As a standard, the prefix "Users." is added at the start of all 
reconciliation field names.

10. Modify the attributemapping_recon.properties file, which is in the 
OIM_HOME/xellerate/XLIntegrations/PSFTHR/config directory.

You can also add new attributes in this file. The format that you must use is as 
follows:

TargetAttribute=Users.OimAttributeName

For example:

SALARY=Users.SALARY

In this example, SALARY is the reconciliation field and also the equivalent target 
system attribute. As a standard, the prefix "Users." is added at the start of all 
reconciliation field names.

Limited Reconciliation
By default, all target system records that are added or modified after the previous 
reconciliation run are reconciled during the current reconciliation run. You can 
customize the reconciliation process by specifying the subset of newly added or 
modified records that must be reconciled. You implement this form of limited 
reconciliation by creating customized queries for reconciliation. You do this by 
creating filters for the reconciliation module.

Creating a filter involves specifying a value for a target system attribute, which will be 
used in the SELECT query criteria to retrieve the records to be reconciled. You can 
specify values for any one or a combination of the following target system attributes:

■ Lastname

■ DeptId

■ Postal

If you want to use multiple target system attributes to filter records, then you must 
also specify the logical operator (AND or OR) that you want to apply to the combination 
of target system attributes that you select.

For instructions to specify values for the target system attributes and the logical 
operator that you want to apply while deploying the connector, refer to the "Specifying 
Values for the Scheduled Task Attributes" section on page 3-19.

Note: You must ensure that the TargetAttribute value that you 
specify does not contain spaces.
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Configuring Incremental Reconciliation

This section discusses the following topics:

■ Configuring the PeopleSoft Listener

■ Encrypting a New Oracle Identity Manager Password

■ Adding a Custom Attribute for Incremental Reconciliation

■ Limited Reconciliation

Configuring the PeopleSoft Listener
This section describes how to configure the PeopleSoft listener. In the following 
procedure, OIM_HOME refers to the local Oracle Identity Manager installation directory

To configure the PeopleSoft Listener:

1. Copy the OIM_HOME/cbrecon_webapp/lib/peopleSoftApp.war file into a 
temporary folder. Enter the following command to extract the contents of the 
peopleSoftApp.war file.

jar –xvf peopleSoftApp.war

2. Edit the deployment.properties file. This file contains the message property 
that corresponds to the name of the XML message from the PeopleSoft feed. The 
default value of this attribute is PSFT_XELLERATE_MSG. Obtain the correct actual 
value for this attribute from the PeopleSoft administrator, and replace the value in 
this file with the actual value.

3. Edit the xlsession.properties file. This file contains the following Oracle 
Identity Manager connection parameters:

■ ObjectName: This is the name of the resource object in Oracle Identity 
Manager against which the reconciliation event is created. The default value is 
PSFT_HR_RO.

■ Username: This is the user name for logging in to Oracle Identity Manager. 
The default value is xelsysadm.

■ Password: This is the password for logging in to Oracle Identity Manager. You 
must enter the encrypted value of the password:

4. Edit the xlclient.properties file. This file contains the following system 
properties that enable an API client to communicate with Oracle Identity Manager:

Note: In this section, the term "attribute" refers to the identity data 
fields that store user data.

Note: All the files mentioned in the remaining steps of this 
procedure are extracted from the peopleSoftApp.war file.

See Also: The "Encrypting a New Oracle Identity Manager 
Password" section on page 3-27 for information about encrypting a 
plaintext password
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■ xl.homedir: This property specifies the Oracle Identity Manager client 
directory. Typically, the Oracle Identity Manager client directory is 
OIM_HOME/xlclient.

■ java.security.policy: This property specifies the path of the security policy file. 
Typically, this file is located in the OIM_HOME/xlclient/config directory.

■ java.security.auth.login.config: This property specifies the path of the 
authentication configuration file. Typically, this file is located in the 
OIM_HOME/xlclient/config directory.

Each application server uses a different authentication configuration file:

IBM WebSphere: authws.conf

BEA WebLogic: authwl.conf

JBoss Application Server: auth.conf

Oracle Application Server: auth.conf

■ java.naming.provider.url: This property specifies the JNP URL of the 
application server. This URL is given in the 
<Discovery><CoreServer><java.naming.provider.url> tag of the 
OIM_HOME/xlclient/config/xlconfig.xml file. Each application server 
uses a different java.naming.provider.url:

– WebLogic: t3://host:7001

– JBoss: jnp://host:1099

– WebSphere: corbaloc:iiop:host:2809

– Oracle Application Server: ormi://localhost:12401/Xellerate

5. Edit the following properties in the configureReconciliation.properties 
file:

■ reconciliationMode: You must always set this property to trusted.

■ Serverdateformat: This property specifies the date format that is used by the 
PeopleSoft server. You can select one of the following date formats:

– dd-mmm-yy

– ddmmyy

– yyddmm

– yymmdd

– dd.mm.yy (if the PeopleSoft installation uses Microsoft SQL Server)

– dd.mm.yyyy (if the PeopleSoft installation uses IBM DB2 UDB)

■ xellerateOrganization: This property specifies the name of the Oracle Identity 
Manager organization. The default value of this property is Xellerate 
Users. The value that you assign to this property must exist in Oracle 
Identity Manager.

■ nullDate: This property specifies the default value for a date field. The value 
is 2200/01/01 00:00:00 PST. This value is used if the date field is left 
empty.

■ PeoplesoftstartingYEAR: This property specifies the year in two digits. If the 
number represented by these two digits (xx):

– Is greater than or equal to 50, then it is assumed that the year is 19xx.
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– Is less than 50, then it is assumed that the year is 20xx.

 This specifies a range of 1950 to 2049 for the property.

■ XelServerDate: This property contains the date format that is used for the 
Oracle Identity Manager server.

Current value of the XelServerDate property: yyyy/MM/dd hh:mm:ss z

■ Filter: This property edits the value for filters, for example, OPRIDLIKE and 
UserType as required. The default value of this property is NO DATA. These 
values are used to configure incremental reconciliation.

6. Copy the following files from the OIM_HOME/xellerate/lib directory to the 
WEB-INF/lib directory:

■ xlAPI.jar

■ xlAuthentication.jar

■ xlBackOfficeBeans.jar

■ xlBackofficeClient.jar

■ xlCache.jar

■ xlCrypto.jar

■ xlDataObjectBeans.jar (for IBM WebSphere Application Server, copy 
this file from OIM_CLIENT/xlclient/lib)

■ xlDataObjects.jar

■ xlLogger.jar

■ xlUtils.jar

■ xlVO.jar

■ xlAdapterUtilities.jar

Copy the following files from the OIM_HOME/xellerate/ext directory to the 
WEB-INF/lib directory:

■ oscache.jar

■ javagroups-all.jar

■ commons-collections.jar

■ commons-digester.jar

■ commons-logging.jar

■ commons-validator.jar

■ jdbcpool-0.99.jar

■ log4j-1.2.8.jar

Note: You must not change this date format.

Note: Delete the following JAR files from the WEB-INF/lib 
directory before you copy the JAR files from the 
OIM_HOME/xellerate/lib directory. 
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■ struts.jar

■ xalan.jar

■ xerces.jar

■ xercesImpl.jar

■ xlRemoteManager.jar

■ xlScheduler.jar

7. Delete the peopleSoftApp.war file from the temporary directory into which 
you extract it, and then use the following command to re-create the file:

jar –cvf peopleSoftApp.war

8. Ensure that the old version of the peopleSoftApp.war file is removed from the 
application server (BEA WebLogic, IBM WebSphere, JBoss Application Server, or 
Oracle Application Server) deployment directory.

9. Copy the newly created peopleSoftApp.war file into the application server 
deployment directory.

10. Restart the Oracle Identity Manager server and client.

Encrypting a New Oracle Identity Manager Password
If the password of the Oracle Identity Manager administrator is different from the 
default password, then you must encrypt the Oracle Identity Manager password as 
follows:

1. On the Oracle Identity Manager server, open a command window.

2. In the command window, change to the OIM_HOME/xellerate/ScheduleTask 
directory.

3. Enter the following command:

java -classpath xlPSFTHRRecon.jar  \
com.thortech.xl.integration.peoplesoft.util.tcUtilEncryption -e \
OIM_plaintext_password

In this command, OIM_plaintext_password is the new Oracle Identity 
Manager administrator password that you want to encrypt.

The encrypted password is displayed in the command window.

4. Replace the value of the encrypted password in the xlsession.properties file 
with the value that you copy from the command window. This file is compressed 
in the OIM_HOME/xlclient/lib/peopleSoftApp.war file.

Note: You can add custom attributes to be reconciled during 
incremental reconciliation. However, you must complete the 
deployment procedure before you can add custom attributes.

Refer to the "Configuring Incremental Reconciliation" section on 
page 3-24 for information about the procedure to add custom 
attributes for reconciliation.

Note: The default administrator user ID is xelsysadm.
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5. Delete the peopleSoftApp.war file from the temporary directory in which you 
extract it, and then use the following command to re-create the file:

jar –cvf peopleSoftApp.war .

6. Ensure that the old version of the peopleSoftApp.war file is removed from the 
application server (BEA WebLogic, IBM WebSphere, JBoss Application Server, or 
Oracle Application Server) deployment directory.

7. Copy the newly created peopleSoftApp.war file into the application server 
(BEA WebLogic, IBM WebSphere, JBoss Application Server, or Oracle Application 
Server) deployment directory.

8. Restart Oracle Identity Manager and the Design Console.

Adding a Custom Attribute for Incremental Reconciliation

Standard incremental reconciliation involves the reconciliation of predefined 
attributes. If required, you can add custom attributes to the list of attributes that are 
reconciled.

The procedure to add a custom attribute for reconciliation depends on the release of 
PeopleTools that you are using:

■ Adding a Custom Attribute for Incremental Reconciliation on PeopleTools 8.22

■ Adding a Custom Attribute for Incremental Reconciliation on PeopleTools 8.45 
Through 8.48

Adding a Custom Attribute for Incremental Reconciliation on PeopleTools 8.22  To add a custom 
attribute for reconciliation on PeopleTools 8.22:

1. Change the PeopleCode given in the HRMSBulkRecon.txt file. This file is in the 
OIM_HOME/xellerate/scripts directory. The required changes are as follows:

a. Modify the following line in the file:

&hdr = 
"EMPLID,LASTNAME,FIRSTNAME,SEX,POSTAL,CITY,SSN,PHONE,BIRTHDATE,COUNTRY,ADDR
ESS,STATE,HIRE_DATE,DEPTID,JOBCODE";

For example, to add the LOCATION column, add LOCATION at the end of the 
list of the list of column names as follows:

&hdr = 
"EMPLID,LASTNAME,FIRSTNAME,SEX,POSTAL,CITY,SSN,PHONE,BIRTHDATE,COUNTRY,ADDR
ESS,STATE,HIRE_DATE,DEPTID,JOBCODE,LOCATION";

b. Modify the SQL statement in the file to retrieve and store the value for the new 
attribute added in a local variable.

For example, to add the job location attribute, LOCATION, to the list of 
attributes that are reconciled, modify the SQL statement as follows:

SQLExec("select DEPTID, JOBCODE, LOCATION from ps_job a where emplid =:1 
and effdt=(select max(effdt) from ps_job b where a.emplid=b.emplid and 
effseq =(select max(effseq) from ps_job c where b.emplid = c.emplid and 

Note: In this section, the term "attribute" refers to the identity data 
fields that store user data. If you do not want to add custom attributes 
for incremental reconciliation, then you can skip this section.
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b.effdt=c.effdt))", &empid, &deptid, &jobcd, &location); 

c. After modifying the header and SQL statement, add the required data to the 
XML message. For example, to add the LOCATION data in the XML message to 
the JOB tag, add the line highlighted in bold in the following code sample:

/* FOR JOB RECORD */
&MSG_ROWSET.GetRow(1).JOB.JOBCODE.Value = &jobcd;
&MSG_ROWSET.GetRow(1).JOB.DEPTID.Value = &deptid;
&MSG_ROWSET.GetRow(1).JOB.LOCATION.Value = &location;

2. Modify the peopleSoftApp.war file based on the custom attribute added. 
Extract the contents of the peopleSoftApp.war file into a temporary directory 
by using the following command:

jar –xvf peopleSoftApp.war

Copies of this file are in the application server deployment directory.

3. In the attributemap.properties file, add the XPath (key-value entry) of the 
custom attribute. For example, you can add the following XPath for the LOCATION 
attribute:

Users.LOCATION=//Transaction/DEPT_TBL/LOCATION

4. Delete the old version of the peopleSoftApp.war file from the temporary 
directory into which you had extracted it, and then enter the following command 
to re-create the file that contains the custom attribute added:

jar –cvf peopleSoftApp.war .

5. Delete the old version of the peopleSoftApp.war file from the application 
server deployment directory.

6. Copy the newly created peopleSoftApp.war file into the application server 
deployment directory.

7. In the Oracle Identity Manager Design Console, make the required changes as 
follows:

a. Add a column corresponding to the new attribute in the User Defined process 
form, UD_PSFT_HR. For the example described earlier, you can add the 
UD_PSFT_HR_LOCATION column for the new attribute added.

b. Add a reconciliation field corresponding to the new attribute in the resource 
object, PSFT_HR_RO. For the example described earlier, you can add the 
Users.LOCATION reconciliation field.

Note: In the attributemap.properties file, the key part of each 
line is the text to the left of the equal (=) sign. You must ensure that the 
key part of the lines does not contain spaces. For example, Users . 
LOCATION, Users. LOCATION, Users.CURRENT LOCATION are all 
invalid key values because they contain spaces.

See: Oracle Identity Manager Design Console for detailed instructions 
on performing the following steps
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c. Modify the PSFT_HR Process process definition to include the mapping 
between the newly added attribute and the corresponding reconciliation field. 
For the example described earlier, the mapping is as follows:

Users.LOCATION = UD_PSFT_HR_LOCATION

In this example, LOCATION is the reconciliation field and also the equivalent 
target system attribute. As a standard, the prefix "Users." is added at the 
start of all reconciliation field names.

8. Restart the Oracle Identity Manager server and client.

Adding a Custom Attribute for Incremental Reconciliation on PeopleTools 8.45 Through 8.48  To 
add a custom attribute for reconciliation on PeopleTools 8.45 through 8.48:

1. Make the required changes in the PeopleCode given in the HRMSCBRecon.txt 
file. This file is in the OIM_HOME/xellerate/scripts directory. The required 
changes are as follows:

a. At the end of the SQL statements section, add a SQL statement to retrieve and 
store the column values for the new attribute in a local variable.

For example, suppose you want to add the department location attribute, 
LOCATION, to the list of attributes that are reconciled. Add the following SQL 
statement to retrieve the values of the LOCATION column from the 
PS_DEPT_TBL table:

SQLExec("SELECT DESCR, LOCATION FROM PS_DEPT_TBL WHERE DEPTID=:1", &deptid, 
&deptname, &location);

b. Add the data fields you retrieved to the XML message. For example, to add 
the LOCATION column to the DEPT_TBL tag, add the lines highlighted in bold 
in the following code sample:

&recnode = &fieldtypenode.AddElement("DEPT_TBL");
&recnode.AddAttribute("class", "R");
&fields = &recnode.AddElement("DEPTNAME");
&fields.AddAttribute("type", "CHAR");
&fields = &recnode.AddElement("LOCATION");
&fields.AddAttribute("type", "CHAR");

c. Add the data text you retrieved to the XML message. For example, to add the 
LOCATION column to the DEPT_TBL tag, add the lines highlighted in bold in 
the following code sample:

&datarecnode = &transnode.AddElement("DEPT_TBL");
&datarecnode.AddAttribute("class", "R");
&datafldnode = &datarecnode.AddElement("DEPTNAME");
&textnode = &datafldnode.AddText(&deptname);
&datafldnode = &datarecnode.AddElement("LOCATION");
&textnode = &datafldnode.AddText(&location);

2. In PeopleSoft Application Designer, copy the contents of the HRMSCBRecon.txt 
file into the savePostChange event for the PERSONAL_DATA component.

3. Extract the contents of the peopleSoftApp.war file into a temporary directory 
by using the following command:

jar –xvf peopleSoftApp.war

Copies of this file are in the application server deployment directory.
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4. In the attributemap.properties file, add the XPath (key-value entry) of the 
custom attribute. For example, add the following XPath for the LOCATION 
attribute:

Users.LOCATION=//Transaction/DEPT_TBL/LOCATION

5. Delete the old version of the peopleSoftApp.war file from the temporary 
directory into which you had extracted it, and then use the following command to 
re-create the file that contains the new attribute:

jar –cvf peopleSoftApp.war .

6. Delete the old version of the peopleSoftApp.war file from the application 
server deployment directory.

7. Copy the newly created peopleSoftApp.war file into the application server 
deployment directory.

8. In the Oracle Identity Manager Design Console, make the required changes as 
follows:

a. Open the process form located in the Development Tools folder of the Oracle 
Identity Manage Design Console.

b. Click Create New Version.

c. In the Create a New Version dialog box, specify the version name in the Label 
field. Save the changes, and then close the dialog box.

d. From the Current Version list, select the newly created version.

e. On the Additional Columns tab, click Add. Add a column corresponding to 
the new attribute in the User Defined process form, UD_PSFT_HR. For the 
example described earlier, you can add the UD_PSFT_HR_LOCATION column.

f. Add a reconciliation field corresponding to the new attribute in the resource 
object, PSFT_HR_RO. For the example described earlier, you can add the 
Users.LOCATION reconciliation field.

g. Modify the PSFT_HR Process process definition to include the mapping 
between the newly added attribute and the corresponding reconciliation field. 
For the example described earlier, the mapping is as follows:

Users.LOCATION = UD_PSFT_HR_LOCATION

In this example, LOCATION is the reconciliation field and also the equivalent 
target system attribute. As a standard, the prefix "Users." is added at the 
start of all reconciliation field names.

9. Restart the Oracle Identity Manager server and client.

Note: In the attributemap.properties file, the key part of each 
line is the text to the left of the equal (=) sign. You must ensure that the 
key part of the lines does not contain spaces. For example, Users . 
LOCATION, Users. LOCATION, Users.CURRENT LOCATION are all 
invalid key values because they contain spaces.

See: Oracle Identity Manager Design Console for detailed instructions 
on performing the following steps
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Limited Reconciliation
By default, all target system records that are added or modified after the previous 
reconciliation run are reconciled during the current reconciliation run. You can 
customize the reconciliation process by specifying the subset of newly added or 
modified records that must be reconciled. You implement this form of limited 
reconciliation by creating customized queries for reconciliation. You do this by 
creating filters for the reconciliation module.

Creating a filter involves specifying a value for a target system attribute, which will be 
used in the SELECT query criteria to retrieve the records to be reconciled. This can be 
done by editing the configureReconciliation.properties file, which contains 
the OPRIDLIKE and UserType parameters.

You can specify values for any one or a combination of the following target system 
attributes:

■ Lastname

■ DeptId

■ Postal

If you want to use multiple target system attributes to filter records, then you must 
also specify the logical operator (AND or OR) that you want to apply to the combination 
of target system attributes that you select.

For instructions to specify values for the target system attributes and the logical 
operator that you want to apply while deploying the connector, refer to the "Specifying 
Values for the Scheduled Task Attributes" section on page 3-19.
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4
Testing the Connector

Testing the connector involves verifying that the PeopleSoft listener can reconcile 
employees into Oracle Identity Manager. This chapter provides instructions to perform 
this test.

Prerequisites for Testing the PeopleSoft Listener Web Application
The following are prerequisites for testing the PeopleSoft Listener Web application:

■ Ensure that the Microsoft Windows scripting engine is installed. This is required to 
run VBScript files.

■ Ensure that the PeopleSoft XML message template is described in the 
psft_xellerate_msg.xml file, which is in the OIM_HOME/xellerate/test 
directory.

Testing the PeopleSoft Listener Web Application
To test the PeopleSoft Listener Web application:

1. In the 
OIM_HOME/xellerate/XLIntegrations/PSFTHR/cbrecon/psft-xel-tes
t.vbs file:

■ Modify the value of the ps_server_url variable so that it points to the URL 
for the PeopleSoft Listener Web application.

■ Specify the required PeopleSoft attributes and employee data values in the 
ExecuteATM function.

2. Run psft-xel-test.vbs. Ensure that the script runs without any errors.

When the script is run, it creates a reconciliation event. Verify that the reconciliation 
event is created in Oracle Identity Manager and that the event contains the data that 
you specify in the VBScript file.
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5
Known Issues

The following are known issues associated with this release of the connector:

■ Secure Sockets Layer (SSL) connections are not supported.

■ The connector files for PeopleTools 8.22 and PeopleTools 8.45 through 8.48 cannot 
be deployed on the same Oracle Identity Manager installation.

■ Different versions of multiple target systems are not supported.

■ Effective dating for future changes to data is not supported.

■ Target resource reconciliation and provisioning are not applicable for this 
connector.

■ In the configureReconciliation.properties file, the following attribute 
values have been set incorrectly: 

– Lastname=Test

– DeptId=100

– Postal=108

– Operator=or

You must edit these attributes to remove the values that are specified. In other 
words change these four lines to the following:

– Lastname=

– DeptId=

– Postal=

– Operator=

■ For successful incremental reconciliation, Oracle Identity Manager must be 
running when a change in employee information takes place in the target system. 
If Oracle Identity Manager were not running, then the XML message generated by 
the PeopleCode event is lost and the change in the employee information is not 
reconciled into Oracle Identity Manager, even if Oracle Identity Manager is started 
later.
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A
Attribute Mappings Between Oracle Identity

Manager and PeopleSoft Employee
Reconciliation

The following table discusses attribute mappings between Oracle Identity Manager 
and PeopleSoft Employee Reconciliation.

Oracle Identity Manager 
Attribute

PeopleSoft Employee 
Reconciliation Attribute Description

EmployeeID PS_PERSON.EMPLID Person ID associated with user

LastName PS_NAMES.LAST_NAME Last name

FirstName PS_NAMES.FIRST_NAME First Name

Sex PS_PERS_DATA_EFFDT.SEX Sex

Postal PS_ADDRESSES.POSTAL Postal address

City PS_ADDRESSES.CITY City name

SSN PS_PERS_NID.NATIONAL_ID National ID provided to user

Phone PS_PERSONAL_PHONE.PHON
E

Telephone number

BirthDate PS_PERSONAL_DATA.BIRTHD
ATE

Date of birth

Country PS_ADRESSES.COUNTRY Country name

Address PS_ADRESSES.ADDRESS1 Contact address

State PS_ADRESSES.STATE State

HireDate PS_EMPLOYMENT.HIRE_DT Date of hire

DepartmentID PS_JOB.DEPTID Department ID

JobCode PS_JOB.JOBCODE Job code
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